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WEPP Interface Bug List 
 
 
This is a list of things in the current version of the WEPP Windows interface (Beta 4.0) that need work.  
 
 

1. Screen parts not always refreshed correctly. Workaround: Resizing the window slightly will 
cause it to redraw correctly. 

 
2. Management heading partially hidden when 3D slope profile displayed. 

 
3. When selecting the input options view using the menu there should be a check mark next to the 

entry (depending on the view) which is missing. Clicking on the menu item still toggles the 
display view but it does not indicate the current setting. 

 
4. Only 5 lines of comment information may be saved although the comment box let you enter more. 

 
5. When selecting a lot of run options the simulation has errors because it can not find a file. 

Workaround: On Windows NT the file windows/system32/config.nt should have  FILES=50 be 
the setting. If FILES=20 is the setting this error will occur. 

 
6. When the slope editor window is maximized and the advanced button is clicked nothing appears 

or the advanced fields appear in the wrong place on the window. Workaround: Click on the 
restore button in the upper left corner of the window to see the extra information. 

 
7. Project set window always stays above other windows. Workaround: Minimize or resize the 

window to not overlap the main hillslope windows. 
 

8. There are rounding errors when parameters are displayed with 4 digits to the right of the  decimal 
point. This is due to converting  between English and metric units. 

 
9. When importing soil files using the archive program  (under the Options menu item) they will not 

show up in the dropdowns on the main expanded hillslope view. 
 

10. In the watershed view the hillslope, channel and impoundment names are not always displayed. 
Workaround: To display the names chose the options menu item and then click Element Names. 
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Frequently Asked Questions 
 

Main Hillslope Window 

How do I run a Simulation? 
Click the Run bottom at the bottom of the hillslope or watershed picture. Brief output is displayed in the 
grid to see more detailed output click on the ”Text Output” or “Graphics Output” buttons. To see what 
outputs the WEPP model is configured to produce click on the “Run Options” button check or uncheck the 
output files you want to see (the simulation will have to be run again to produce the output files). The 
simulation will run for the number of years indicated above the output grid.  

How do I make it Run Faster? 
The WEPP model will run the fastest if the fewest number of options are selected in the Run Options. Click 
the “Run Options” button to select what output files to produce. The number of different management 
sections and soil sections on the hillslope also effects how fast a simulation is done, again less sections 
produce faster simulation times. 

Can I import files from the DOS interface? 
Climate file can be interchanged between the two interfaces. The other files are not compatible. In the 
future the Windows interface will have an import tool to read DOS hillslope projects. 

Adding a break in a soil or management gives an error? 
The WEPP model only supports setting up 10 distinct soil and management sections, trying to add more 
will display an error. 

The colors for the shading in the watershed or hillslope are “blocky”? 
This is probably due to the color setting being used for your display. To get the best shading Windows 
should be set to use “High Color” or “True Color”. A color setting of 256 colors does not show all the 
shading. The color setting can be changed by right clicking on the Windows desktop and then selecting 
properties and then the “Settings” tab and selecting an item from the Colors list.  

Change between English and metric on the main screen? 
Click the toolbar button with the E/M this toggles the units on the main screen and also causes other 
windows that are opened to default to that units setting. 

Resize the grid area at the bottom of the expanded view? 
With the mouse cursor hovering over the border between the grid and the main hillslope graphic the cursor 
should change to a vertical arrow. Click and hold down the left mouse button and drag the boundary to a 
new location. The position of the boundary is not saved when the project is closed; it is always initialized to 
a default position when the project is opened. 

Change the slope length?  
There are two ways to change the slope length. To preserve the current shape proportions select the middle 
layer of the hillslope graphic by clicking on it with the right mouse button and picking the “change length” 
menu item. Type in the new length in the dialog and click OK. To make other changes to the slope double 
click on the slope layer to display the slope profile editor. Changing the steepness or segment lengths of the 
sections will cause the slope length to change. When the changes are saved in the slope profile editor they 
will be reflected on the main display. 
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Change the length of a management section? 
There are two ways to change the length of a management section. Move the mouse cursor over the desired 
section and then right-click to display a menu, select the “change length” menu item. Type in the new 
length in the dialog and click OK. Another (less precise) method is to move the cursor over a dividing line 
between management sections; the shape will change to a horizontal arrow. Clicking and holding the left 
mouse button while dragging the dividing line will reposition it, releasing the left mouse button completes 
the move. 

Add a management section? 
There are two ways to add a management section. In both cases a “break” dividing line must be inserted 
where you want the new field boundary. The new management section initially has the same management 
as the section where the break was inserted. A break can be inserted by hovering the mouse over the 
location on the management layer where you want the boundary and then right click and select “insert 
break” from the menu. Alternatively select the break icon (black triangle) from the toolbar which causes the 
cursor to change shape and enter break insert mode. Any place you left click on the management layer 
inserts a break after answering yes to the popup window. To exit break mode left click anyplace on the 
background or click the break icon again (the cursor will return to an arrow shape). 

Delete a management section? 
To delete a management section right click while over the section and then select the delete item, Choose 
OK when asked to confirm the operation. 

Change the length of a soil section? 
There are two ways to change the length of a soil section. Move the mouse cursor over the desired section 
and then right-click to display a menu, select the “change length” menu item. Type in the new length in the 
dialog and click OK. Another (less precise) method is to move the cursor over a dividing line between soil 
sections; the shape will change to a horizontal arrow. Clicking and holding the left mouse button while 
dragging the dividing line will reposition it, releasing the left mouse button completes the move. 
 

Add a new soil section? 
There are two ways to add a soil section. In both cases a “break” dividing line must be inserted where you 
want the new soil boundary. The new soil section initially has the same soil as the section where the break 
was inserted. A break can be inserted by hovering the mouse over the location on the soil layer where you 
want the boundary and then right click and select “insert break” from the menu. Alternatively select the 
break icon (black triangle) from the toolbar which causes the cursor to change shape and enter break insert 
mode. Any place you left click on the soil layer inserts a break after answering yes to the popup window. 
To exit break mode left click anyplace on the background or click the break icon again (the cursor will 
return to an arrow shape). 

Delete a soil section? 
To delete a soil section right click while over the section and then select the delete item, Choose Yes when 
asked to confirm the operation. The delete icon on the toolbar (X icon) can also be used, first left-click on 
the section to delete to select it (section will have diagonal lines when selected) then click the delete icon 
on the toolbar and finally choose yes when asked to confirm the operation. 
 

Change a soil section? 
To change to a different soil right-click on the section to change and choose Import. The soil import list 
window will be displayed, double click on the soil to be used. To change the properties of a soil double-
click on the soil section to change to display the soil editor, change any fields and click “Save”. 
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Change a management section? 
To change to a different management right-click on the section to change and choose Import. The 
management import list window will be displayed, double click on the management to be used. To change 
the details of a management section or create a new management double-click on the management section 
to change to display the management editor, change any fields and click “Save”. 
 

Create a new project? 
A new project can be created by making changes to an existing project and then choosing File and then 
Save As to give the project a new name. 

Change the climate? 
To change the climate used in a simulation an existing climate can be imported by right-clicking on the 
climate icon (the sun in the upper left corner) and selecting the import menu item. The climate import list 
window will be displayed, double click on the climate to be used. To change the details of a climate or 
create a new climate file double-click on the climate icon to display the climate editor, change any fields 
and click “Save” or “Save As”(to create a new climate file).  
 

Change the number of years to simulate? 
The number of years used in the simulation is determined by the number of years selected in the run 
options. Click the Run Options button and adjust the number of years to simulate. The length of simulation 
can not be longer than the number of years of climate data available. Attempting to run a project for more 
years than there is available data will display a warning message indicating the simulation will stop at the 
end of the climate data and not run for the number of years the user has requested. 

Change the text above on a management section? 
This text is displayed on the 3D view of a hillslope. Double click on the management section to change to 
display the management editor and type in a new description at the bottom and click “save”. 

Print hillslope text output? 
From the File menu choose the Print or Print Preview menu items. 
 

Print the soil loss graph or other graphs? 
Move the mouse over the graph and then right-click to display a menu of options. Choose “Export”, in the 
export window select Metafile and Printer options. You can also save the graph so that it can imported into 
other programs by saving to a file or the clipboard. 

Copy output to another program? 
Results can be copied to any program that uses the Windows clipboard. From the Edit menu choose “Copy 
Results” after running a simulation. In the other program (such as Notepad, Excel, Word) select Paste to 
import the text. 

Change what variables are displayed in the graphics output? 
The WEPP model can produce 91 daily output values in the graphics file. To limit the number of variables 
the user can choose from click on the “Customize” toolbar button (checkmark icon) and select the Graphics 
tab. Indicate which variables to display by putting a checkmark next to the name. Click “Apply” to record 
the changes. The next the graphics output window is displayed only those variables selected will be 
displayed. 
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Change the project that is created when the user clicks ‘New’? 
Click on the “Customize” toolbar button (checkmark icon) and select the Projects tab. Choose a new 
default template project from the list and click “Apply”. The next time the File|New menu item is clicked 
this project will be displayed. 

Change the default project that is displayed when the program starts? 
Click on the “Customize” toolbar button (checkmark icon) and select the Projects tab. Choose a new startup 
project from the list and click “Apply”. The next time the program is started the new project will be the 
default project displayed. 
 

Display English units as the default? 
Click on the “Customize” toolbar button (checkmark icon) and select the View tab. Check the “Use English 
Units” box. and click “Apply”. The next time the program is started English units will be the default. 

Display Metric units as the default? 
Click on the “Customize” toolbar button (checkmark icon) and select the View tab. Uncheck the “Use 
English Units” box. and click “Apply”. The next time the program is started metric units will be the default. 
 

Change the shape of the hillslope profile? 
To use slope description already built hover the mouse cursor over the middle slope layer on the main 
graphic and right click and choose Import. . The slope import list window will be displayed, double click 
on the slope to be used. To change the properties of a slope (or create a new slope file) double-click on the 
slope layer to display the slope editor, change any fields and click “Save”. To create a new slope file use 
“Save As” in the slope editor window. 
 

Run several projects in a single operation? 
This is done by creating a project set. From the File menu choose “New Project Set”, when the project set 
window is displayed click the “Add Projects” button and hold down the ctrl key and left click the projects 
to include in the set. Choose OK. Click “Select All” and then “Run Selected projects” to start of the 
simulations. 
 

Remove projects from a project set? 
Select the line in the grid with the project you want to remove by clicking on the number at the beginning 
of the line to highlight the line. After the line is highlighted use the right-mouse button to display a menu 
and select the remove item. 

Can I see graphs from multiple runs at once? 
The soil loss graph can remain active while a different project is run. Clicking on the soil loss button after 
the second project has been run will display another graph window. The additional graphics outputs can 
only be displayed for one project at a time. 

Slope Editor 

How do I get to the slope editor? 
From the main hillslope picture double click on the middle slope layer. You can also select the middle layer 
and then right-click to display the menu and then click View/Edit. 
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The grid describing the slope was changed but the picture is not correct? 
After updating the grid click the preview button to graph the data in the grid. 
 

Make the graph larger and zoom in? 
The whole slope editor window can be resized. To zoomin on a section of the graph click the left mouse 
button and drag and release across the area you want to see. To restore the graph to its original view type 
‘z’ or right-click and choose “unzoom”. There are also extensive customizations you can do with the graph, 
right-click while over the graph to see a menu. 

Change the direction the hillslope is facing? 
Click the Advanced button and change the Aspect field to indicate degrees from North. Be sure to click 
Save or Save As to apply the change to the slope file. 
  

Change the width of slope? 
Click the Advanced button and change the Profile Width field to a new value. Be sure to click Save or Save 
As to apply the change to the slope file. 
  

Make the transition area smoother between segments? 
Click the Advanced button and change the Transition % field to a larger number and then click the preview 
button. 
  

Make the transition area sharper between segments? 
Click the Advanced button and change the Transition % field to a smaller number and then click the 
preview button. 
 

What is "line" versus "curve" mode? 
Line mode means that input data is in the form of line segments with associated lengths and slopes. The 
slope is the average slope over the segment. Curve mode indicates that the input is in the form of 
cumulative distances from the top of the hillslopes with the slopes defined at those specific points on the 
profile.  
 

The message "Bad Length" is displayed but everything looks OK? 
Make sure the line following the last line of data has no spaces by highlighting the row and clicking the 
backspace or delete key. 
  

Soil Editor 
  

How do I display the soil editor? 
From the main hillslope picture double click on the bottom slope layer and the desired soil section. You can 
also select the soil section and then right-click to display the menu and then click View/Edit. 
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Create a new soil? 
Click the SaveAs button and give the soil a new name. 
 

Delete a soil? 
Click the Delete button and then click OK when asked to confirm the delete operation. The current soil can 
not be deleted, a different soil must first be imported into the soil section and the soil editor displayed so 
the unused soil can be selected and then deleted. 
 

Change the color of the soil section? 
Click the colored box above the help button and select a new color from the window, click OK to apply the 
color. After doing this the box will be the color of the soil section. Click the Save button to make the 
change permanent. 
  
 

Management Editor 
  

How do I display the management editor? 
From the main hillslope picture double click on the top slope layer and the desired management section. 
You can also select the management section and then right-click to display the menu and then click 
View/Edit. 
  

What does the picture at the top represent? 
This graphically shows the operations that are being doing in the management schedule in the table below 
the picture. Moving the mouse over the image will highlight the row in the table below that represents the 
operation. The green lines represent the period during which a crop is planted till when it is harvested. 
There are buttons to scroll by month or year and to zoom in and out. 
 

Change the color of a management section? 
Click the colored button and select a new color from the window, click OK to apply the color. After doing 
this the box will be the color of the management section. Click the Save button to make the change 
permanent. 
 

Change the tillage depth or plant spacing? 
Click on the yellow folder icon between the operation and its name. This will display a detailed parameter 
listing for that operation. At the bottom there is an entry field for either tillage depth or plant row spacing 
where a new number can be entered.  
 

Delete lines in the management schedule? 
To delete a line or group of lines in the management table select the line by left clicking on the number 
column which highlights the row then right-click and select the delete rows menu item. 
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Insert new lines in a management schedule? 
Select the line in the table where the new line is to come before by clicking on the first column. Right-click 
and select Insert Row from the menu that is displayed. The new line is inserted with the data filled in from 
the selected line.  
 

Insert an existing management file into the schedule? 
Select the line in the table where the new file is to come after by clicking on the first column. Right-click 
and select Insert Rotation file from the menu that is displayed. Select the rotation file from the window that 
is displayed. The year dates in the schedule may be adjusted to account for the inserted operations. 
 

Change the year for a group of operations? 
Highlight the lines where the year is to be changed and then right-click and select “Change Year” from the 
menu. In the field type in the new starting year – if the highlighted rows can rotations that span several 
years the differences in years will be preserved.  
 

Change the type of operation? 
Move the cursor to the operation you want to change and click in the field, an arrow will be displayed in 
the right part of the field click it to display a list of operations to choose from. Choosing a new operation 
will cause the name column to change – click in this column to select the desired record. 
 

Change the parameters used for a specific operation? 
For most operations there are a set of parameters the WEPP model requires for simulation. Click on the 
folder icon to display further details about an operation.  
 

Find out what all the detail operation parameters represent? 
From each of the detail operation parameter windows you can click the F1 key to display a description of 
what the fields mean. More detailed information can be found in the User Summary document. 
 

Some of the text is chopped off, how do I see it all? 
The columns in the table and rows can be resized. To make a row taller move the cursor to the first column 
and move the mouse over the line dividing the rows (the cursor will change shape). Hold the left mouse 
button down and drag the line to resize the height. To make a column wider move the mouse over the 
column lines on the top row till it changes shape. ). Hold the left mouse button down and drag the line to 
resize the width. The grid size changes are not preserved when the window is closed. 
 

Why are some rows different colors? 
Fields that are gray can not be changed from the management table, these values are for information. The 
values in the 2 rightmost columns can be changed by clicking the folder icon. The date columns change 
color depending on the year of the operation. The first row of initial conditions is always orange. 
Add new entries to the name lists? 
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Climate Editor 

How do I display the Climate Editor? 
Double click on the climate icon on the main hillslope window or watershed window. 
 

How do I create a new climate? 
First, display the climate editor and then select the state and station desired. Click the Save-As button and 
enter a file-name in the window that is displayed. The CLIGEN program will then generate the daily 
climate data and put it in the specified file. The file can then be imported in any existing project by right-
clicking on the climate icon and then choosing import and then the desired file. 

How do I see what climate data is actually used by WEPP? 
After running a simulation click on the text output button and then double-click on the climate input file in 
the list. 
 

What is CLIGEN 4.3 and CLIGEN 5.1? 
The CLIGEN programs are separate climate generators that produce WEPP daily climate input based on 
statistical distributions found in actual measured data. Version 4.3 is currently being used and version 5.1 is 
being evaluated. Both versions are included with the Windows interface. More information is about 
CLIGEN is available from http://horizon.nserl.purdue.edu/Cligen 

How do I use my own climate data? 
The input file must be prepared in breakpoint format which is described in the WEPP User Summary 
document (available using the online help from the program or at the NSERL website).  The interface can 
prepare this format from NOAA 15 minute precipitation data, from the climate window select the 
“breakpoint data” and proceed to import the 15 minute precip file. There is also a separate breakpoint 
climate generator program is also included with the install. The program and documentation can be found 
in the C:/Program Files/USDA/WEPP/Data/climates/bpcdg directory. 
 

Can I use Actual Daily Climate data? 
Yes this is done from the climate window, select the “Actual Daily” item on the left. This data can be in 
several formats (including importing from NOAA Summary of Day dataset). This option only requires 
precip, minimum and maximum daily temperatures. The other climate parameters required by WEPP are 
generated by CLIGEN. The storm durations and intensities in the resulting climate file should be reviewed 
because these are generated from the CLIGEN parameter file independent of the daily input data. 
 

How do I create a new international climate station? 
From the tools menu click on the Add Climate item and select the country and give the station a name. The 
windows that follow will optionally allow you to choose a similar US station and also setup the CLIGEN 
PAR file from actual data you may have. 
 

How do I create a new US climate station? 
From the tools menu click on the Add Climate item and select the state and give the new station a name. If 
the station is in the continental US the location can be selected on the map window that is displayed. The 
option of interpolating the CLIGEN PAR file from nearby stations is allowed. The CLIGEN parameters 
can also be determined from actual daily data.  
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Can a single storm event be modeled? 
Yes. A design storm climate file can be created from the climate editor by choosing the Single Storm or Tr-
55 storm types and then clicking the Save-As button. 

Watershed Screen 
 

Run a watershed simulation? 
To display a watershed screen click on File and then the Open Watershed menu item. Select one of the 
watershed projects (.prw files) to load. To run a WEPP simulation click on the Run button (green circle).  

How can a new watershed be created? 
From the watershed menu select File and then Save As to create a new watershed project based on an 
existing project. 

Why are some buttons on the left toolbar grayed? 
Some buttons display output functions and are only available after a run. Other buttons are not active when 
the hillslopes are being displayed as polygons. 

Can the direction of the channel or hillslope faces be changed? 
Double click on the compass in the upper left of the view. When the window is displayed double click on a 
new orientation to use for the watershed. 

How do I change the properties of a channel? 
Move the mouse cursor over the channel (blue rectangle on diagram) until the name of the channel is 
displayed. Double click to bring up the channel properties. From this screen you can select a new soil, slope 
shape or detail parameter set for the channel. You can also right-click and choose view-edit to change the 
channel properties. 

How do I change the length or width of a channel? 
The length can be changed by clicking and dragging  one of the two endpoints on the channel to change the 
length. The length or width can also be changed by moving the mouse cursor over the channel until the 
name of the channel is displayed. Right-click to display a menu of channel operations and select either the 
“change length” or “change width” items and type in the new value in the window that is displayed. 

How do I change the slope of a channel? 
To change the slope shape for a channel you can import an already existing slope file or create a new slope 
file. Move the mouse until the channel name is displayed then double-click. From the list of slope files 
select a new shape – the graph to the left displays the shape of the slope. To customize the slope shape or 
create a new slope file click on the folder to the right of the list to display the slope editor. 

Change the length of a hillslope? 
To change the length of a hillslope move the mouse cursor over the hillslope and right-click to display a 
menu of hillslope operations and select “Change Length”.  Type in the new value in the window that is 
displayed. You can also click and drag one of the edges to changes the size. 
 

Change the shape of a hillslope? 
Double click on the hillslope which will open another window showing the hillslope profile. Right-click on 
the middle slope layer to import a slope file or double-click to enter the slope editor to create a new slope 
file or modify the current file. 
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Make the diagram larger (or smaller)? 
There are two buttons on the hillslope toolbar that zoomin and zoomout. 

Reposition the drawing to the center of the screen? 
Move the mouse over the outlet channel (green) and when the channel name appears click and hold down 
the left mouse button (the cursor shape will change to 4 arrows). Drag the channel to another position and 
release the left mouse button to complete the move. The hillslopes attached to the channel will be moved 
automatically. 
 

Save or print outputs from a simulation run? 
Click on File and then Print or “Print Preview” which will print a brief summary of the configuration and 
results. For more detailed listing click the “Text Output” button and click on the output file to view, the file 
is displayed using Windows Notepad it can then be printed. 

Change the climate used in a watershed simulation? 
Click the climate icon (sun) in the center of the window and choose a climate station to generate input data. 

See the soil or management breaks on the hillslopes? 
Click on the right toolbar icon with the small plant to show management sections. Click on the toolbar icon 
with the soil layers to show soil sections. 
 

View or change the details associated with a hillslope? 
Double-click on a hillslope to display the profile view. From this view you can change the slope shape, 
soils or management. 
 

Why is the only hillslope where the width can be changed the top? 
The hillslope widths on the left and right sides of a channel are constrained to match the length of the 
channel. The hillslope feeding a channel from the top can have any length or width. 

Remove a hillslope from the top, left or right of a channel? 
Right-click while over the hillslope to remove and select “Delete” from the menu that is displayed. Click 
Yes when asked to confirm the delete operation. You can also use the Delete key after a hillslope is 
selected. 

Add a hillslope to the top, left or right of a channel? 
With the mouse cursor over the channel right-click and choose the “Add Hillslope” menu item. The 
positions relative to the channel where a hillslope can be added are shown to the right of the menu item. 
The items, which are grayed, cannot be selected because a hillslope is already in that position. 
 

Add a new channel? 
Select an existing channel or impoundment by using a left-click. When the channel is selected right-click 
and use the Add Channel menu item to choose where to add the channel. 

Add a new impoundment? 
Select an existing channel or impoundment by using a left-click. When the channel is selected right-click 
and use the Add Impoundment menu item. Drag the impoundment to the desired size. 
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View soil loss averages? 
Click the Options menu item then the Soil Loss by Hillslope item. 
 

Use an Image as the background? 
Bitmap files (.bmp) and JPEG files (.jpg) can be used. Click the Tools menu then Change background and 
then import image. Select a file to use as the background. 
 

Scale the background image? 
Select the Tools menu and then Scale Map. Click two points and enter a distance to use.  
 

Why is one channel green? 
The green channel is the watershed outlet channel, all elements drain into it. 
 

What is the yellow ball? 
This indicates the watershed outlet point. 
 

View slope shapes and color/legend information? 
Click on the legend toolbar button (top button on right watershed toolbar) and drag the dividing line 
between the legend and watershed view. Click on the checkboxes at the top of the legend window to 
display additional information. 
 

The hillslope labels and channel labels disappeared how can they be made 
visible? 
Click on the Options menu item and then select Element Names. 

Outputs 

The graphics output button can never be clicked? 
The graphics button is only enabled if the WEPP model produced a graphics output file with daily 
simulation data. Click the Run-Options button and make sure the graphics output is checked, rerun the 
simulation if this was not selected. 

How are WEPP output files viewed? 
Click on the “Text Output” button at the bottom of the hillslope image. A window containing a list of 
output (and input) files related to the WEPP simulation are displayed. Double-click on a view to view it in 
Notepad. 

What does the data in the input files mean? 
These are the files that the Windows interface has generated as input to the WEPP FORTRAN model. The 
file formats are described in the WEPP User Summary document.  

What is the WEPP Run Messages File? 
This is default output from the WEPP model that would normally be sent to a users terminal screen. The 
Windows interfaces saves this data to display any error or warning messages a simulation run had. 
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Can the text output files be saved or printed? 
When the files are displayed in Notepad you can print or choose File and then Save As.  

What do the names “p0, p1, etc” mean? 
Each hillslope project opened is assigned a unique id so that the any input and output files generated are 
kept separate for each project.  

Is there a way to only see only a few graphic output choices? 
Click on the Options menu and select “Preferences” click on the Graphics tab and only have checks next to 
the variables you are interested in. The next time the graphics output is viewed the list will only show those 
items. 

Can the graphics output have English units? 
Currently the WEPP model only logs the daily values in metric; the Windows interface does not yet have 
conversion functions to support graphs in English units. 

Can the graph style be changed? 
Click on the style list in the graph setup window to select a new style and then click the “Display” button to 
redraw the graph. You can also right-click the graph to display a menu and choose “Viewing Style” and 
then select a new style from the list. There are many more options available from right-clicking on the 
graph. 

Can I zoomin to see an area in more detail? 
Left-click and hold down the mouse button to select a starting position and then drag the line to the desired 
ending point and release the left mouse button. To restore the graph to the original view type ‘z’. 

Can I display multiple graphs? 
Upto 4 separate graphs can be displayed at one time. Click one of the 4 circles at the top of the window to 
indicate which of the four available graph windows will be displayed. Click the “Display” button to show 
the graph window. 

Can a graph be printed? 
Move the mouse over the graph and then right-click to display a menu of options. Choose “Export”, in the 
export window select Metafile and Printer options. You can also save the graph so that it can imported into 
other programs by saving to a file or the clipboard. 
 

Databases 
  

Can database entries be deleted? 
The current interface can add new records based on existing data, modify any records created or delete any 
records created. However, database files distributed with the interface are read-only and can not be 
changed. New records are created and modified using the individual editors such as slope, soil, 
management, crops, operations. To delete records use the Tools menu and select Database Maintenance.  
 For information that is stored in files such as soils, slopes, managements or projects the files can be deleted 
using Windows Explorer. The files are located in subdirectories under the directory C:\Program 
Files\USDA-ARS\WEPP\Data 
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Where is the information stored? 
The files in the directory C:\Program Files\USDA-ARS\WEPP\Data with an extension of .db contain 
records related to different management operations. Rotation schedules are stored one per file in the 
directory  Data/Managements Slope files are stored one per file in Data/Slopes Soil files are stored one per 
file in Data/Soils Hillslope and watershed project files are stored Data/Projects 
Output files generated by the model are not saved. 
 

How do I create a new record? 
To create new files or records click on Save As in any database editor screen. This also applies to soils, 
climates, slopes and management data files. 
 

Why can’t some files or records be changed? 
The files and records included with the WEPP installation are read-only.  New files or records can be 
created by clicking the SaveAs button in the various edit windows.  Any user created files or records can be 
changed.  

Other 

How can I report bugs or suggest changes? 
Email to wepp@ecn.purdue.edu 

Where can I find the latest version? 
Check the WEPP webpage at http://topsoil.nserl.purdue.edu/weppmain/wepp.html 

After running the Uninstall there are still WEPP files left? 
Any files changed or added after WEPP was installed are not deleted. After running the uninstall the 
remaining files in the WEPP install directory can be deleted using Windows Explorer (the default 
installation directory is c:\Program Files\usda-ars\WEPP 
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